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Den digitala bildens grunder 
 
Analog eller digital? 
 

�  En analog bild, till exempel ett diapositiv eller en pappersbild, innehåller områden och 
detaljer som är kontinuerligt färgade.  

�  Värden för tonomfång och genomskinlighet anges i densitet och mäts med en densitometer.  
�  En densitometer används också för kvalitetskontroll vid tryckning. Med hjälp av 

densitetsvärdena kan man ange tryckytans och tryckprocessens färgåtergivning. 
 

 
 
En digital bild består av pixlar (bildpunkter). 
 

�  En digital bild består av bildsignaler i form av ettor och nollor.  
�  En bild kan omvandlas till digital form med en digitalkamera eller skanner (bildläsare) eller 

till exempel genom att man omvandlar en rörlig bild på videoband till digitalt format. I de 
flesta minidv-videokameror är det möjligt att spara stillbilder på ett eget minneskort.  

�  Man kan också skapa digitala bilder direkt på en dators bildskärm, genom att till exempel 
rita eller vektorisera former i olika program (bl.a. Freehand, Illustrator).  

�  Digitala bilder kan hanteras på ett mångsidigt sätt i datorn. Exempelvis solarisationseffekten 
på fotografier, som kräver ett flertal skeden då den utförs manuellt, kan åstadkommas med 
ett enda filter i Photoshop (Filter > Stilisera > Solarisera; Filter > Stylize > Solarize).  

 
Fördelar med digitala bilder 
 

�  Bilderna kan produceras snabbare och förmånligare. Man sparar in på framkallningstid samt 
på film och annat fotomaterial.  

�  Det är mer ekologiskt att producera bilderna. Man behöver inte framkallnings- eller 
fixermedel för att behandla bilderna. Å andra sidan används färgbläck vid utskrift av digitala 
bilder. 

�  Genast då fotot tas märker man om bilderna är lyckade.  
�  Det är lätt att kopiera digitala filer. Vi kopieringen behålls dessutom kvaliteten om inte 

bilden komprimeras. En bild som sparas i till exempel jpg-format komprimeras alltid. När 
man sparar bilden på nytt i jpg-format komprimeras en redan komprimerad bild och 
bildkvaliteten blir sämre för varje gång. 

�  Det har blivit allt enklare att korrigera och retuschera bilder. I Photoshop 7 kan man jämna 
ut ansiktsrynkor med det nya verktyget Lagningspenseln (Healing Brush Tool) på några 
sekunder.  
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�  Den dyra reproduktionen (jfr rastrering av bilden med en reprokamera) är snabbare och 
förmånligare.  

�  Genom att ändra bildformat och upplösning kan man dra nytta av bilden i flera medier.  
 
Nackdelar med digitala bilder 
 

�  Det blir allt lättare att bryta mot upphovsrätten. Så till exempel kopierar man en bild från 
internet med ett par musklick. 

�  Bildens värde som dokument sjunker eventuellt, men det har nödvändigtvis inte skett 
överallt. Bilderna i bildbankerna är fortfarande värdefulla, även om det går snabbt och 
smidigt att ladda ner bilderna. Fördelarna med digital fotografering har ökat antalet bilder 
och fotografering överhuvudtaget. 

�  Gamla yrken (bl.a. ombrytare, reprokameraanvändare) försvinner och nya kommer inte 
alltid i stället. Exempelvis på Aamulehti övergick man i mitten på 1990-talet helt till 
ombrytning på dator varvid de traditionella ombrytarna förlorade sina jobb.  

�  Arbetet har blivit mer tekniskt, vilket alla kanske inte anser vara en nackdel.  
�  Det går inte att förstora digitala filer av en viss storlek så att kvaliteten bevaras. Det går till 

exempel inte att göra en bra affisch av en bildfil på 500 kilobyte. Däremot är det lätt att 
förminska storleken. 

 
Original 
 
Originalen delas vanligen in i två grupper: påsiktsoriginal (reflective) och genomsiktsoriginal 
(transparences). 
 
Påsiktsoriginal är bl.a.  
(flatbädds- och trumskannrar) 

�  ritningar, illustrationer, råkopior etc.  
�  utskrifter och fotografier  
�  tryckt material (när man skannar en redan tryckt bild, uppkommer i den nya bilden lätt en så 

kallad moiré-effekt, dvs. den tryckta bildens rastervinkel syns i den nya bilden. Man kan 
försöka minska på moiré antingen genom att ändra vinkeln på bilden i skannern eller genom 
att använda ett bildbehandlingsprogram).  

 
Genomsiktsoriginal är bl.a.  
(trum- och diaskannrar) 

�  diapositiv och negativ  
�  annat grafiskt filmmaterial. 

 
Filmnegativ bör inte förstoras över 800 procent, eftersom kornigheten då blir alltför stor och bilden 
blir oskarp. För affischer och större reklamplakat används i allmänhet storformatsdior eller lagring i 
digital form. På det sättet bevarar bilden sin skärpa trots förstoringen. 
 
Standardformat och hur de används 
 

�  1/4 basbild 384 x 256 pixel, medieanvändning och preliminär bild (low-res) vid trycksaker 
�  basbild 768 x 512 pixel, bildskärm och tv-ruta. I PAL-systemet är tv-rutan 720 x 576 pixel 
�  4 x basbild 1536 x 1024 pixel, för trycksaker (t.ex. postkort) och medier 
�  16 x basbild 3072 x 2084 pixel, trycksak(A4) (high-res). 
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Källor för digitala bilder 
 
Skannrar (bildläsare) 
 

�  Trumskanner. Bästa bildkvaliteten, för krävande och stora trycksaker (t.ex. affischer), 
upplösning upp till 8000 ppi (pixel per tum), 8–14-bitars färgdjup. Trumskannrar används i 
huvudsak på tryckerier och reklambyråer vid reproducering.  

�  Diaskannrar. Högklassig bild, upplösning 300–3000 ppi, 12-bitars färgdjup. 
�  Flatbäddsskannrar. Rätt anspråkslös kvalitet, upplösning 200–1200 ppi, 8-bitars färgdjup. 

Flatbäddsskannrarna är fördelaktiga köp också för den vanliga konsumenten. Passar bra för 
mindre bildutskrifter och trycksaker samt för bilder på skärmen. 

 
Digitalkameror 
 
Digitalkamerornas bildupplösning växer snabbt med att nya modeller lanseras. 
 

�  Proffskameror, för reklam- och produktfoton (minst 6,9 miljoner pixel). Proffsen gynnar 
också gamla studio- och bänkkameror som är försedda med digitala bakstycken. 

�  Högklassiga baskameror, för utskrifts- och mediebehov (minst 5 miljoner pixel).  
�  Amatörkameror av fickstorlek som numera kan ha upp till 4–5 miljoner pixel, även om 2–3 

miljoner pixel är vanligast. Användningen av digitala pocketkameror kommer att öka 
ytterligare. Man uppskattar att 5–10 procent av hela kamerabeståndet i Finland i slutet av år 
2003 utgörs av digitalkameror (källa: Mikropc:s Digikuvaajan opas). 

 
Problemen med digitalkamerorna har varit varierande lagringsformat, låg bildupplösning och de 
höga prisen på minneskort. Till exempel Canons kameror har använt i huvudsak CompactFlash-
minneskort. De största korten rymmer upp till en gigabyte, vilket innebär att en stor mängd bilder 
får plats på kortet. Antalet bilder är dock beroende av bildupplösningen. Kortprisen har gått ner 
under de senaste åren, men ännu för några år sedan kostade ett kort på 128 megabyte ungefär 1000 
mk. Just nu (oktober 2003) kostar ett kort på 512 megabyte ca 160 euro. 
 
I Olympus kameror används ofta SmartMedias minneskort. Olika lagringsformat kräver var sin 
läsare som kopplas till datorn. Med hjälp av läsaren fungerar minneskortet som vilken diskett som 
helst. Man kan alltså överföra bilder till datorn via dem. 
 
Kvalitetskraven på skannrar och digitalkameror är en bra färgupplösning och tillräcklig skärpa samt 
att apparaten fungerar stabilt. Ett bra objektiv är också viktigt i digitalkameror. 
 
Andra källor  
 
Ritprogram  
 

�  I de flesta bildbehandlingsprogram kan man rita med olika ritverktyg (t.ex. penna eller 
pensel).  

�  Vektorbaserade ritprogram är exempelvis Illustrator (Adobe) och Freehand (Macromedia). 
Också med Flash kan man åstadkomma ritningar, även om programmet är avsett närmast för 
animationer på nätet. 

�  Det är lättare att rita på skärmen med en tryckkänslig pekplatta än med en mus.  
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Animationsprogram 
 

�  Exempelvis Flash och olika gif-animationsprogram. 
�  Med Flash kan man rita vektorgrafik och från en animation kan man importera enstaka rutor 

in i ett bildbehandlingsprogram. 
 
3D-program  
 

�  Exempelvis 3D Studio Max, Bryce, AutoCAD, Maya.  
�  Används t.ex. vid planritningar, produktplanering, konst, animationer och spel. 
�  Med ett 3D-program kan man animera objekt och skapa en illusion av tredimensionella rum 

med hjälp av belysning.  
�  En bild som producerats med ett 3D-program kan bearbetas i ett bildbehandlingsprogram 

eller infogas direkt i exempelvis Flash. 
�  Programmen är ofta dyra och besvärliga att använda. 

 
Digitala videor 
 

�  Det är möjligt att kopiera stillbilder från en digital video. Bildernas upplösning räcker till för 
en bildskärm eller tv-ruta, men däremot inte för trycksaker. 

 
Kopior av bilder på internet  
 

�  Högerklicka på bilden och välj Spara bild som (Save Image As) för att spara bilden på din 
egen dator.  

�  Det är lätt att spara bilderna, men också för dem gäller upphovsrätten.  
�  Man kan förse bilderna med en digital identifikation för att kunna spåra hur de används, t.ex. 

om de publiceras på internet utan tillstånd. 
�  Bilder som får användas fritt är ofta av dålig kvalitet och för kraftigt komprimerade.  

 
Skärmbildskopior (screenshots) 
 

�  Man kan kopiera fönster i andra program eller till och med hela webbsidor (Print Screen). 
 
Bilder från fotoaffären direkt på cd-rom eller till ett b ildgalleri på internet  
 

�  Cd-romskivor är behändiga lagrings- och arkiveringsmedier.  
�  Fotoaffärernas bilder på webben finns tillgängliga i allmänhet bara under en viss tid. 
�  Bilderna är ibland slarvigt skannade och deras upplösning otillräcklig för trycksaker.  
�  Bilderna på webben har ofta färgfel; alla bilder kan t.ex. vara grönaktiga. 

 
Bildbyråer 
 

�  Man kan köpa bilder på cd-rom, både enskilda och ämnesvis, från bildbyråer. Royaltyfria 
bilder är rätt fördelaktiga, men de får i regel inte användas för kommersiellt bruk. 

�  Bildbyråer på webben: Lehtikuva (http://www.lehtikuva.fi/), Compad 
(http://www.compad.fi/) och Magnum (http://www.magnumphotos.com/). 

 
Då man kopierar en bild från internet eller bildskärmen gör man sig ofta skyldig till brott mot 
upphovsrättslagen. Man behöver alltid upphovsmannens tillstånd då man använder sig av bilderna. 
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Upplösning 
 
Begreppet upplösning (resolution) används i tre olika sammanhang: 1) vid skanning, 2) i bilder, 3) 
på skärmen. 
 
1) Skanningsupplösning (ppi / dpi) 
 

�  Skanningsupplösningen är i princip samma som bildens upplösning. Men man har nytta av 
att skanna bilder med en större upplösning än vad man har behov av, eftersom det då är 
lättare att bearbeta dem. Upplösningen kan sedan ändras i ett bildbehandlingsprogram. 

�  ppi = pixels per inch (pixlar per tum) eller dpi = dots per inch (punkter per tum).  
�  Enheten innebär antalet pixlar i förhållande till något mått, vanligen tum.  
�  Skanningsupplösningen för en bild bestäms av vad bilden kommer att användas till. Om 

bilden t.ex. ska publiceras på webben räcker upplösningen 72 dpi, även om det inte alltid är 
förnuftigt att skanna in direkt med den här upplösningen. Om bilden ska behandlas på 
skärmen bör man välja en upplösning på t.ex. 150 dpi.  

 
2) Bildens upplösning (ppi / dpi) 
 

�  En lämplig standard för en skärmbilds upplösning är 72 ppi.  
�  Upplösningen i trycksaker är ofta 300 ppi. För tryck på tidningspapper räcker 180 ppi.  
�  Ju större upplösning, desto fler detaljer kan urskiljas på bilden, men bildens storlek växer. 

Man försöker låta storleken av en bild på webben vara så liten som möjligt genom att 
optimera bilden. Det gör man genom att välja ett lämpligt bildformat (i allmänhet gif eller 
jpg) samt komprimera bilden tillräckligt, men inte för mycket. 

�  Enheten för bilder på skärmen är pixel (eller punkt), för trycksaker millimeter eller 
centimeter. 

 
3) Skärmens upplösning 
 

�  För t.ex. en 17 tums skärm rekommenderas upplösningen 1024 x 768 pixel och högst 1280 x 
1024 pixel. 

�  För hög upplösning gör tecknen på skärmen diffusa och anstränger ögonen. En alltför stor 
upplösning lämpar sig inte alls för noggrann bildbehandling.  

 
Bitmappsgrafik (punktuppbyggd grafik) 
 
Allmänt 
 

�  En bitmappsbild (punktuppbyggd bild) är ett rutnät som bildas av pixlarna (bildpunkterna), 
där en pixel är ett kvadratiskt bildelement. 

�  I en 1-bits svartvit bild kan en pixel vara antingen svart eller vit.  
�  I en 24-bits fullfärgsbild kan en pixel ha en av 16,7 miljoner färger.  
�  Antalet färger ökar bildens filstorlek, men man kan minska filstorleken genom att 

komprimera bilden.  
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1-bits bild 
 
Bildens bitdjup och information 
 

�  Bildens storlek utgörs av det sammanlagda antalet pixlar (bredd x höjd), t.ex. 640 x 480 = 
307 200 eller 800 x 600 = 480 000.  

�  Bildens detaljskärpa växer med antalet pixel (täthet).  
�  Bildens bitdjup anger antalet färger i bilden.  
�  1 bit = 2 färger 
�  2 bitar = 4 färger 
�  4 bitar = 16 färger 
�  8 bitar = 256 färger osv.  
�  En 24-bitars RGB-bild bildas av tre 8-bitars kanaler, var och en med 256 färger (256 x 256 x 

256 = 16,7 milj. färger). 
 
Bildfilens storlek 
 
bredd (pixel) x höjd (pixel) x bitdjup / 8 = bildfilens storlek i byte. 
 
Exempel:  
300 (pixel) x 400 (pixel) x 24 / 8 = 360 000, dvs. 360 kB (kilobyte)  
800 (pixel) x 600 (pixel) x 24 / 8 = 1 440 000 kB, dvs. 1,44 MB (megabyte). 
 
Interpolation 
 

�  När bildens upplösning ändras eller om bilden roteras (rotate) eller skalas (scale) i ett 
bildbehandlingsprogram måste bilden interpoleras, dvs. pixlarna måste ordnas på nytt.  

�  En algoritm undersöker omkringliggande pixlar och ger pixlarna nya värden. Photoshop har 
följande algoritmer att välja emellan: bi-kubisk (bicubic), bi-linjär (bilinear), närmaste 
granne (nearest neighbourhood).  

�  I Photoshop: Storlek på bild > Ändra bildupplösning (Image size > Resample Image).  
 
Den digitala bildens huvudtyper 
 
Streckbild (line-art, bitmap) 
 

�  Ett bildelement består av 1 bit; 1 = vit och 0 = svart.  
�  Lämpar sig för teckningar, t.ex. tuscharbeten, svartvit streckgrafik och text.  
�  Upptar ett litet utrymme vid lagring eftersom inga färger förekommer, men kräver i alla fall 

en hög upplösning för att visa detaljer noggrant.  
 
Gråskalebild (grayscale)  
 

�  En 8-bitars bild med 256 gråtoner; 0 = svart och 255 = vit.  
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�  Kräver 8 gånger större lagringsutrymme än en streckbild. 
�  Lämpar sig t.ex. för svartvita fotografier. 
�  Kan tryckas. 

 
Färgbild (RGB, CMYK) 
 

�  En RGB-bild har 24-bitars information (miljoner färger).  
�  Kanalerna Red, Green och Blue har var och en 256 färger. 
�  För bilder på skärmen. 

  
�  En CMYK-bild har 32-bitars information.  
�  Kanalerna Cyan, Magenta, Yellow och Black har var och en 256 färger. 
�  För bilder i tryck.  

 
Indexerad färgbild (indexed color) 
 

�  8-bitars bildinformation. Man har tillgång till 256 färger.  
�  Lämpar sig bra för ritad färggrafik, men inte för fotografier. 
�  För bilder på skärmen. 

 
Grafik och färg 
 

 
 
RGB-färgmodellen 

 
 
CMYK-färgmodellen 

 
  
Färgsystemen RGB och CMYK uppvisar motsatt beteende. När man trycker alla tryckfärger på 
varandra får man svart färg, men om man på en skärm använder kanalernas högsta värden på 
varandra i RGB-färgsystemet får man rent vitt.  
 
RGB 
 
Ljuset består av tre huvudfärger: röd, grön och blå. RGB-systemet är ett additivt färgsystem för 
ljuset. Ju fler färger man har, desto ljusare färg får man. Varje färg (röd, grön och blå) har 256 olika 
färgnyanser (0–255). 
 
Funktionen hos datorns bildskärm, tv:n och annan utrustning som förmedlar eller filtrerar ljus 
baserar sig på det här färgsystemet. RGB-färgerna fungerar omvänt jämfört med ögat. De (skapar 
och) reflekterar rött, grönt och blått ljus. 
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Det här färgsystemet används vid bildbehandling på skärmen, t.ex. på internet och cd-rom samt i tv.  
 
CMYK (processfärger)  
 
CMYK är ett subtraktivt färgsystem. När ljuset träffar objektet, suger det in en del av färgerna och 
reflekterar resten. Vi ser det ljus som reflekteras. 
 
Färgsystem som används i trycksaker 
 
När färgerna cyan, magenta och gul trycks på varandra borde ren svart färg uppkomma. I 
verkligheten uppstår grå eller brunskiftande färg, vilket i allmänhet beror på att de tryckfärger som 
används innehåller orenheter. Det här felet korrigeras genom att man lägger till svart (Key) 
tryckfärg. 
 
Eftersom CMYK-färgerna trycks en åt gången i lager, bör de vara genomskinliga (transparenta). 
Endast i undantagsfall används ogenomskinliga (opaka) färger.  
 
  

 
 
Cyan och svart 

 
 
Magenta och svart 

 
 
Gul och svart 

 
 
Svart 
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Alla CMYK-färger 
 

 

 
 
HSB (hue, saturation, brightness) 
 
Nyans (hue) är en ren färg som ingår i regnbågen. 
 
Mättnad (saturation) anger färgens renhet. Om mättnaden är 0 är färgen grå. Vit, svart och grå har 
ingen mättnad. 
 
Med intensitet (brightness) anges värde på mörkhet och ljushet. Om intensiteten är 0 är färgen svart. 
Kallas också ljusstyrka. 

 
 
Vektorgrafik 
 

�  Vektorgrafikens skärpa och noggrannhet baserar sig på användning av matematiska kurvor 
(s.k. bezierkurvor). En vektorbild kan förstoras obegränsat utan att skärpan försämras. 

�  Det är lätt att bearbeta en bild med hjälp av kurvorna. 
�  Sättet att rita utgående från vektorer planerades ursprungligen för cad-tillämpningar.  
�  Kallas också för elementgrafik eller objektgrafik.  
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En bezierkurva – formerna kan ändras efter ritandet 
 
Användning av vektorgrafik 
 

�  Affischer 
�  Grafik där man använder klara kontraster och färgytor. 
�  Företagsgrafik i olika medier, av olika storlek och med olika skärmupplösning. 
�  Logotyper och texteffekter där man behöver skarpa och jämna kanter. Teckensnitten kan 

brytas ner till vektorstigar och bearbetas på nytt. 
�  Broschyrer och reklamblad med bilder, logotyper och text. 
�  Planritningar (arkitektur), produktplanering och andra streckritningar.  
�  Med Flash kan man skapa elegant, men lätt vektorgrafik samt animation på webben.  

 
Fördelar och nackdelar  
 

�  Filerna är små.  
�  Grafik, logotyper och teckensnitt kan förstoras utan att bildkvaliteten lider av det (jfr 

pixelgrafik).  
�  Skalande av vektorgrafik kräver stor räknekapacitet av datorn, eftersom vektoriseringen 

grundar sig på matematiska värden.  
 
 
Skanning med flatbäddsskanner 
 
Med skannern följer ett program för den egentliga bildinläsningen. I programmet kan man välja 
originalets typ, t.ex. färgbild, svartvit bild, färgritning, svartvit ritning. Man kan också reglera 
bildens kontrast och intensitet, spegelvända bilden eller ändra den till ett negativ. Det är dock en bra 
idé att finjustera och efterbehandla bilden i ett bildbehandlingsprogram eftersom det är lätt att ångra 
funktionerna där. När man skannar en avgränsad bild kan man inte senare göra den större, utan man 
måste skanna bilden på nytt.  
 
Man kan använda skannern också direkt i ett bildbehandlingsprogram. I exempelvis Photoshop 
väljer man Arkiv > Hämta in > Twain (File > Import > Twain). 
 
Val av upplösning vid skanning 
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Man väljer skanningsupplösning utgående från det slutliga ändamålet med bilden. Om t.ex. bilden 
ska publiceras på webben räcker en upplösning på 72 dpi, men det inte alltid förnuftigt att skanna 
direkt med den här upplösningen. Det är avsevärt lättare att behandla och frilägga bilder med högre 
upplösning. Efter bearbetningen är det lätt att förminska och optimera den till rätt storlek. 
 
När man väljer skanningsupplösningen är det också väsentligt att veta om bilden kommer att 
förstoras eller förminskas. Om man vill få en bild som är dubbelt så stor som originalet, bör man 
skanna med åtminstone dubbel upplösning. 
 
Skanning 
 
1. Placera bildoriginalet i flatbäddsskannern med bildsidan neråt. 
 
2. Öppna bildbehandlingsprogrammet och välj Arkiv > Hämta in > Twain (File > Import > Twain) 
eller motsvarande funktion. 
 
3. Välj Förhandsgranska (Preview), varvid skannern läser in och visar en råversion av bilden. 
Avgränsa det område som ska skannas. Runt bilden bör du lämna en vit kant så att hela bilden 
säkert sparas. 
 
4. Välj originalets typ, t.ex. Färg(foto) (Color (photo)), samt upplösningen. Det är en bra idé att 
skanna bilder som ska på webben med lite större upplösning än nödvändigt (t.ex. 150 dpi), speciellt 
om du måste bearbeta bilden. Minska upplösningen efter bearbetningen till 72 dpi så att den lämpar 
sig för webben. 
 
5. Om bildens färger och nyanser måste ändras och programmet har lämpliga justeringsmetoder, bör 
du utföra behövliga åtgärder (kontrast, intensitet, färgbalans, färgmättnad o.d.). Om bilden däremot 
ser någorlunda bra ut är det lämpligt att utföra justeringarna först i bildbehandlingsprogrammet. 
 
6. Välj Skanna (Scan) och spara bilden på önskad plats i exempelvis tif-format. I ett senare skede 
kan du byta format och optimera bilden så att den motsvarar ändamålet.  
 

Val av utskriftsupplösning  

Utskrift  Bildens upplösning (dpi) 

För internet eller skärmen 72–75 

Svartvit laserutskrift 100–150 

Tidning 150–180  

Färglaser 150–180 

Bläckskrivare (600 dpi) 180–200 

Bläckskrivare (1200 dpi) 250–300 

Fyrfärgstryck 300 eller mera 

. 

På din egen skrivare kan du pröva med lägre upplösningar än vad ovanstående lista rekommenderar. 
Det papper som används vid utskriften påverkar också utskriftskvaliteten. 
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Du får det bästa jämförelsematerialet om du skriver ut samma bild med olika upplösning. 

Lägg också märke till att upplösningen ändras då bilden förstoras och förminskas.  
Om t.ex. den skannade bildens upplösning är 200 dpi och du förstorar bilden 200 procent blir 
bildens upplösning 100 dpi. När du förminskar bilden ändras upplösningen naturligtvis åt andra 
hållet i motsvarande grad. 

 
Skanning av text 
 
När man skannar in text med ett skannerprogram får man vanligen en bild som inte kan redigeras 
med ett ordbehandlingsprogram. Om textbilden behandlas med ett textigenkänningsprogram (OCR–
program = Optical Character Recognition) kan den sparas, beroende på programmet, i ett sådant 
format att den identifieras av olika ordbehandlingsprogram. 
 
Om inte textigenkänningsprogrammet är försett med stavningskontroll bör du först med hjälp av 
ordbehandlingsprogrammet granska om det uppstått fel (ju högre textkvalitet, desto färre fel) och 
sedan efter det inleda den egentliga ordbehandlingen.  
 
Textigenkänningsprogrammet identifierar egentligen inte text eller ord, utan tecken, vilka man 
också kan lära programmet att känna igen. Problem kan uppstå vid tolkning av skandinaviska 
tecken med prickar och om textkvaliteten är låg. 
 
Skanning av text utan ett OCR-program  
 

1. Placera bilden i flatbäddsskannern med bildsidan neråt (kolla att bilden är rak).  
 
2. Välj streckbild som skanningstyp.  
 
3. Välj upplösningen 300 dpi. 
 
4. Förhandsgranska bilden och avgränsa det område som ska skannas.  
 
5. Välj kommandot Spara (Save) och ange önskat lagringsformat.  

 
Skanning av text med ett OCR-program 
 

1. Placera bilden i flatbäddsskannern med bildsidan neråt (kolla att bilden är rak).  
 
2. Skanna texten.  
 
3. Läs texten med OCR-programmet och spara texten. 
 
4. Om ingen stavningskontroll ingår i OCR-programmet bör du stavningskontrollera och 
redigera med ett ordbehandlingsprogram. 

Skärmens upplösning 

På bildskärmens mått inverkar skärmens fysiska storlek (t.ex. 17 tum), använd upplösning samt 
grafikkortet. Grafikkortet ritar upp bilden på skärmen. 

Skärmens skärpa  
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Vilken som helst upplösning (resolution) lämpar sig inte för vilken skärmstorlek som helst, utan det 
finns rekommendationer för vilken skärmstorlek som ska ha vilken upplösning. I tabellen anges 
vägledande upplösningsvärden för de vanligaste skärmstorlekarna. 

Skärmens storlek Lämplig  Maximum  

15" 800 x 600 1024 x 768 

17" 1024 x 768 1280 x 1024 

19" 1280 x 1024 1600 x 1200 

För stor upplösning gör tecknen på skärmen suddiga och anstränger ögonen. Speciellt när det gäller 
noggrann bildbehandling passar en för stor upplösning inte alls. 

Skärmbildens kvalitet påverkas också av uppdateringsfrekvensen som anger hur många gånger i 
sekunden skärmen uppdateras. För låg frekvens medför att skärmen flimrar. Också grafikkortet 
påverkar valet av uppdateringsfrekvens. Rekommenderad minimifrekvens är 72 Hz. Både 
upplösning och uppdateringsfrekvens kan ändras via Kontrollpanelen i Windows 
(bildskärmsikonen). 

Antalet färger på skärmen  

För att visa färger använder datorns bildskärm följande tre huvudfärger: röd (Red), grön (Green) 
och blå (Blue), dvs. den tidigare nämnda RGB-färgmallen. 

Skärmens upplösning och webben 

Det mest problematiska vid planering av webbsidor är att användarna har skärmar av olika storlek 
och kvalitet. Hur ska man planera en webbplats så att den fungerar bra vid olika 
skärmupplösningar? 

Åren 1995–1997 var största delen av skärmarna av storleken 14 eller 15 tum och hade i allmänhet 
upplösningen 640 x 480 eller 800 x 600 pixel. Vid planeringen beaktar man i allmänhet den minsta 
upplösningen som används, det vill säga i det här fallet 640 x 480 pixel. Även om 17 och 19 tums 
skärmar har blivit allmännare efter år 2000, planeras webbsidorna fortfarande vanligen för 
upplösningen 800 x 600. Man kan lösa upplösningsproblemet genom att definiera sidans tabeller, 
ramar osv. relativt, det vill säga i procent, inte i pixel. På det sättet anpassas sidans storlek efter 
skärmen. Nackdelen är att det då är svårt att skapa en elegant och genomarbetad layout, eftersom en 
skalbar sidas bilder, text och andra element rör sig olika på olika skärmar. 

Samma problem uppkommer vid bildplanering. Man kan säga att en fotograf som vill ha en bild på 
skärmen som är hälften av skärmstorleken står inför en omöjlig uppgift. På en skärm med storleken 
800 x 600 borde bildens storlek vara 400 x 300 pixel. Men alla skärmar använder inte samma 
inställningar. Planeringen av bilder och sidor för webben är full av kompromisser. 

Jämför exempel där samma bild förekommer med två olika skärmupplösningar: 
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En bild av storleken 800 x 600 pixel på en skärm vars upplösning är 1152 x 864. 
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En bild av storleken 800 x 600 pixel på en skärm vars upplösning är 1600 x 1200. 

 
De vanligaste bildformaten 

I och med man utvecklat egna format för olika program har antalet filformat ökat. Endast ett fåtal 
program stöder över tio format. Bilder som sparats med en nyare programversion kan inte med 
säkerhet mera öppnas i en äldre version, även om den gamla programversionen stöder just det 
filformatet. 

raw 

�  Ett grundläggande bitmappsformat för överföring mellan olika program och datormiljöer. 
�  Används exempelvis som format för mobiltelefonernas logotyper. 
�  Stöder de flesta färgformat (RGB, CMYK, grayscale osv.).  

bmp  

�  Ett bitmappsformat.  
�  Utvecklat av Microsoft och IBM som standard för bitmappsbilder.  
�  Fungerar bara i IBM-kompatibla pc-datorer.  
�  Allmänt i Windowsmiljö. 

tiff -> trycksaker  

�  Tagged Image File Format har utvecklats tillsammans med Aldus skannerteknik och är ett 
av de äldsta, allmänt kända filformaten.  

�  Det finns åtminstone tre versioner av tif-formatet (4.2, 5.0 och 6.0). 
�  Kan utnyttja den effektiva LZW-komprimeringen.  
�  Ett allmänt format för lagring vid skanning, eftersom tif-bilder öppnas i de flesta program 

som stöder det här formatet.  
�  Bilden kan sparas i RGB- eller CMYK-format.  
�  Pc-datorer och mac-datorer använder olika byteformat. 

eps -> trycksaker 

�  Encapsulated PostScript. 
�  Både vektor- och pixelbilder kan sparas i det här filformatet.  
�  Filen består av en utskriftsdel och en skärmdel.  
�  Filen kan bli rätt stor. 

jpeg -> webben  

�  jpg eller jpeg.  
�  Joint Photographic Expert Group.  
�  Ett filformat som komprimerar bilden och som lämpar sig bra för foton på webben.  
�  Komprimeringssättet begränsar inte antalet färger, dvs. man har miljoner färger till 

förfogande.  
�  Bilden kan komprimeras till en hundradel av den ursprungliga. 
�  Stöds av webbläsarna utan tilläggsmodul (plug-in).  
�  Komprimeringen förenar pixlar med liknande färger, men den ändrar inte intensiteten.  
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�  Ett informationsförstörande komprimeringssätt, varför man ska undvika att spara på nytt.  
�  För mycket komprimering gör bilden suddig. 
�  Lämpar sig bra för fotografier på webben.  

gif -> webben 

�  Graphics Interchange Format.  
�  Ett filformat för överföring av bilder, utvecklat av CompuServe. 
�  Kan använda högst 256 färger.  
�  Fungerar bäst för ritningar, logotyper, färggrafik och ikoner, men inte för fotografier.  
�  Stöds av webbläsarna utan tilläggsmodul (plug-in).  
�  Stöder sammanflätningsteknik (interlace). Bilden visas först oskarp på skärmen och blir 

sedan gradvis skarpare. 
�  Kan animeras (gif-animation).  
�  Stöder bara indexerat färgformat (Indexed Color).  
�  Önskade färger kan göras genomskinliga så att man till exempel kan bädda in grafik på en 

webbsida utan störande kanter.  
�  Passar för ritningar och annan grafik på webben. 

  psd -> PhotoShops arbetsfil för tilläggsbehandling och bevarande av originalbilden (master)  

�  Adobe Photoshops eget filformat.  
�  Bevarar information om bl.a. använda färglägen och lager (layers).  
�  Filen kan bli stor om flera lager använts i bildbehandlingen.  
�  En psd-fil som skapas i en pc kan öppnas i en Mac. 
�  En psd-fil konverteras till slut så att den lämpar sig för användningsändamålet, t.ex. vid 

tryck till tif-format eller eps-format.  

png -> webben  

�  Portable Network Graphics. 
�  Stöder funktionerna sammanflätning och bakgrundsgenomskinlighet. 
�  Innehåller en alfa-kanal. 
�  Kan ha upp till 48-bits färger, vilket medför att bildfilerna kan bli mycket stora.  
�  Komprimeringen är icke-förstörande. 
�  Komprimerar en bild 10–30 procent effektivare än gif. 
�  Fungerar inte i webbläsarna Internet Explorer eller Netscape utan en tilläggsmodul (plug-in). 

Av den orsaken har formatet inte fått större spridning.  

pdf -> webben eller tryck 

�  Portable Document File baserar sig på PostScript och är ett format för överföring, 
förhandsgranskning och utskrift, oberoende av operativsystem. 

�  Kan innehålla vektorgrafik och bitmappsbilder. 
�  Det är möjligt att bädda in teckensnitt. 
�  Kan innehålla aktiva länkar. 
�  Behöver Acrobat Reader för läsning och Distiller för ändring. 

Spara bilder på webben 
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Det är en god idé att alltid spara ett duplikat av en färdig bild. Ofta måste man ta fram den på nytt 
för att göra små ändringar i den. Det är allt skäl att spara originalet i Photoshops eget psd-format så 
att alla lager, alfakanaler och andra element finns kvar. 

När du sparar bilden – och naturligtvis redan när du påbörjar arbetet – bör du ha klart för dig till vad 
bilden ska användas. Om bilden kommer på en webbsida eller en cd-romskiva bör den optimeras till 
minsta möjliga filstorlek. 

Genomskinliga gif-bilder  

Genomskinliga gif-bilder (och, mera sällan, png-bilder!) används ofta på webbsidor när man vill 
bädda in bilden i bakgrunden på en sida eller t.ex. en tabell. Det här lyckas bäst när bakgrunden 
utgörs av jämna färgytor. Det är nästan omöjligt att bädda in en genomskinlig gif-bild i en alltför 
brokig bakgrund. I så fall är det värt att överväga om man kan genomföra det hela på något annat 
sätt, exempelvis genom att använda bildcollagen som sådana och optimera hela bilden. 

Spara som gif-bild med användning av Photoshops Gif89a-Export 

1. Ta ett duplikat av originalet med Bild > Duplicera (Image > Duplicate).  

2. Sammanfoga bildens lager till ett lager med Lager > Gör till ett lager (Layer > Flatten Image). 
Efter det här kan du inte mer göra ändringar i de olika lagren.  

3. Kolla att upplösningen är 72 pixel/tum. 

4. Välj Bild > Läge > Indexerad färg (Image > Mode > Indexed Color). Antalet färger i bilden 
minskas nu till 256, men i allmänhet är också det för mycket för webben! Du måste ytterligare 
minska antalet färger i bilden. 

5. Välj exempelvis Adaptiv (Adaptive) i rutan Palett (Palette) och Färgdjup 6 bitar/pixel. Obs! I 
vanliga fall konverteras bara grafik som är ritad eller gjord för hand till gif-format. Ett fotografi 
sparas i allmänhet i jpg-format (undantag: om man vill ha genomskinliga element i bilden). 

6. När du indexerat bilden och minskat antalet färger så att bilden fortfarande ser bra ut, måste du 
spara den med Arkiv > Spara som (File > Save as). Om du vill ha genomskinliga element sparar du 
genom att välja Arkiv > Exportera > GIF89a-export (File > Export > Gif89a Export). 

7. Nu ser du kanske bara en del av bilden i en liten ruta. Du kan ta bort eller ändra färgerna till 
genomskinliga genom att klicka med pipetten antingen på bilden eller på färgrutorna under bilden. 
Genomskinliga områden blir gråa. Om du vill att bilden ska laddas gradvis (från suddig till skarp) 
markerar du kryssrutan Sammanfläta (Interlace). Klicka sedan på OK. 

8. Namnge bilden. 

Spara som gif-bild med Photoshop (versionerna 6 och 7) 

Skarpkantad genomskinlighet 

Med skarpkantad genomskinlighet avses ett sådant slutresultat där pixelkanterna kan urskiljas. 
Bilden har i så fall inte egenskapen kantutjämning (antialiasing), där pixelkanterna tonas in i 
bakgrunden genom delvis genomskinliga pixlar. 
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Ett psd-original med vit bakgrundsfärg. Man vill dock förse bilden med en grå 
bakgrund. 

Gör bakgrundslagret osynligt genom att 
klicka. 

Välj Arkiv > Spara för webben (File > Save for Web). 
Se till att kryssrutan Genomskinlig (Transparency) är 
markerad. När du sparar bilden på det här sättet pixlas 
bildens kanter kraftigt, vilket innebär att bilden nu kan 
användas med vilka som helst färgade bakgrunder.  

I rätt storlek ser bilden inte så ”ryslig” ut som i den förstorade bilden 
ovan. Till höger visas den slutliga gif-bilden som bäddats in i en grå 
bakgrund med Dreamweaver. 

Genomskinlighet i förhållande till önskad bakgrund 

Utgångspunkten samma som ovan. Vi börjar alltså med att öppna ett psd-
original vars bakgrundsfärg är vit. Vi vill bädda in bilden i en grå bakgrund 
med hjälp av Dreamweaver. 
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Gör bakgrundslagret osynligt genom att 
klicka och välj därefter Arkiv > Spara för 
webben (File > Save for Web). Se till att 
kryssrutan Genomskinlig (Transparency) 
är markerad och välj i rutan Matte den 
gråa färg som du vill ha som bakgrund. 
Du kan ändra färg med t.ex. pipetten eller 
genom att välja custom i rutan Matte. På 
det sättet kan du välja exakt önskad färg. 

Matte-färgen visas vid bildens kanter. Det här gör det 
möjligt för dig att bädda in bilden i bakgrunden på ett 
vackrare sätt än med föregående metod. 

Slutresultatet är en genomskinlig gif-bild som bäddats in elegant i bakgrunden. 

Obs! Du kan spara bilden i gif-format också genom att använda kommandot Spara för webben 
(Save for Web). På det sättet kan du behändigt optimera bilden genom att använda 
förhandsgranskningen (t.ex. 4-up). Lägg speciellt vikt vid bildens kvalitet i förhållande till 
filstorleken. 

Spara bilden som en jpg-bild 

Låt jpg-bilden vara i RGB-läge. Kolla bildens storlek och upplösning. 

1. Välj Lager > Gör till ett lager (Layer > Flatten Image). 

2. Välj Arkiv > Spara som (File > Save as) och därefter formatet JPG. 

3. Namnge bilden och klicka på Spara (Save).  
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Du kan komprimera jpg-bilden med olika komprimeringsgrad (kompressionsgrad). Du bör 
naturligtvis i regel använda den bästa kvaliteten, dvs. Maximum i rutan Kvalitet (Quality), men ofta 
används det här formatet för att minska bildstorleken. Jpg-algoritmen värderar bilden i block på 8 x 
8 pixel och förenar de pixlar som har samma färg. Det är inte bra att spara på nytt en redan sparad 
jpg-bild, eftersom man då komprimerar en redan komprimerad bild. Det är all anledning att följa det 
rådet åtminstone då bildens komprimeringsgrad är hög (t.ex. kvaliteten 5). 

I dialogrutan finns tre alternativknappar. Det rekommenderas att du använder inställningen Baslinje 
(standard) (Baseline (Standard)). Inställningen Progressiv (Progressive) lämpar sig inte för utskrift 
av bilder. Då du har valt det här alternativet laddas bilden gradvis enligt principen: ju större antal 
inläsningar du har angett, desto snabbare visas en preliminär bild på skärmen. 

Obs! Du kan spara bilden i jpg-format också genom att använda kommandot Spara för webben 
(Save for Web). På det sättet kan du behändigt optimera bilden genom att använda 
förhandsgranskningen. Lägg speciell vikt vid bildens kvalitet i förhållande till filstorleken. För låg 
komprimeringskvalitet gör bilden suddig. 

Komprimeringsgraderna i Photoshop 7 då du sparar med kommandot Spara för webben (Save for 
Web): 

�  låg (0–29) 
�  medium (30–59) 
�  hög (60–79) 
�  maximum (80–100). 

När du sparar med kommandot Spara som (Save As) är komprimeringsgraden 0–12 enligt följande: 

�  låg (0–4) 
�  medium (5–7) 
�  hög (8–9) 
�  maximum (10–12). 
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Du kan reglera komprimeringen noggrannare med det första sättet. 

Valet av komprimeringsgrad påverkas av bl.a. originalets färger och nyanser samt ändamålet med 
bilden. Grundprincipen är: välj den komprimering som minskar filstorleken så mycket som möjligt, 
men där kvaliteten fortfarande är god. I Photoshop kan man jämföra kvaliteten i dialogrutan Spara 
för webben (Save For Web), eftersom den kan visa tre komprimeringsgrader utöver originalet. De 
numeriska värdena för komprimeringsgraderna är olika i olika program. I t.ex. Mac-datorer är 
komprimeringen 0–4 och inte 0–100. När man talar om en jpg-bilds komprimeringsgrad eller 
komprimeringsförhållande är det skäl att nämna också den programversion som använts för 
komprimeringen. 

En komprimeringsgrad på 75 anses ofta vara gränsen för iögonenfallande ändringar i bilden. För 
miniatyrbilder (thumbnails) kan den största komprimeringen vara t.ex. 5–10 grader, eftersom redan 
den ringa storleken tar bort behovet att visa bilden med stor noggrannhet. Då komprimeringsgraden 
är 30–50 kan ändringarna vara märkbara, men inte nödvändigtvis störande. Slutresultatet beror på 
originalet. Bilder som ska publiceras på internet kan ha en komprimeringsgrad på 30–50. När allt 
kommer omkring kan det vara bäst att spara på bildens laddningstid snarare än på dess kvalitet. Å 
andra sidan kan också bildens fysiska storlek förminskas. 

 

Förstoringen visar tydligt hur en kraftig komprimering sammanför pixlarna. Pixlarna sammanförs i 
block på 8 x 8 pixel, vilket åstadkommer artefakter, dvs. förvanskningar i färgblocken och 
kontrastrika gränsytor. 
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Bilden har sparats i jpg-format och komprimerats på bästa möjliga sätt. Filstorleken är 285 
kilobyte. 

 

Bilden har sparats i jpg-format och komprimerats med komprimeringsgraden 50. Filstorleken är 
55,5 kilobyte. Jämfört med föregående bild kan man inte upptäcka stora skillnader i kvaliteten, 
varför man helst väljer den här komprimeringsgraden. 
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Bilden har sparats i jpg-format och komprimerats med komprimeringsgraden 2. Filstorleken är 
18,6 kilobyte. Man märker tydligt hur bilden har blivit suddig på grund av för stor komprimering. 
Lägg märke till exempelvis havet samt bladens och klippornas konturer. 

Bildens filstorlek 

Enligt allmänna riktlinjer för webbsidors användbarhet (t.ex. Jakob Nielsens anvisningar) bör 
endast små bilder läggas ut på internet, eller så ska man försöka undvika dem helt och hållet. Varje 
kilobyte medför att sidan laddas långsammare hos användaren, och varje sekund som åtgår till 
väntan på att sidan laddas minskar antalet användare. Man bör alltså noggrant överväga 
användningen av bilder och se till bildens filstorlek är tillräckligt liten. 

Laddningen av en bild på 26 kilobyte tar ungefär 10 sekunder med ett långsamt modem (28,8 kbps). 
Med snabba ISDN-anslutningar räcker laddningen av samma bild ca 3 sekunder. På en webbsida 
kan finnas flera bilder, vilket medför att laddningstiden för hela sidan kan uppgå till flera sekunder, 
till och med minuter. En möjlighet är att använda s.k. miniatyrbilder (thumbnails), dvs. små bilder 
som kan klickas fram till en större version.  

En allmän regel är att sidans storlek inte får överstiga 100 kilobyte. Inom den offentliga sektorn kan 
man ange 50 kilobyte som maximivärde. Det här minskar väsentligt möjligheten att använda bilder 
och grafik. 
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